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1 Introduction
Various Vizrt systems feature Animation Store transitions, providing full color overlays embedded 
in each transition, per-pixel A/B source selection at each point, realtime cloth dynamic effects, and 
slow-motion interpolation so the transition (and overlay) can be run at any speed and still look 
fabulous.

The included Animation Store Creator allows talented artists to easily author custom Animation 
Store transitions, using their own preferred graphics software tools to prepare the animation 
sequences displayed during the transition.

Some video systems provide a number of ‘animation stores’ to supply animated color overlays 
during transitions. Configuration can be a cumbersome multi-step operation. As well, since only a 
few effects are loaded at any time, users must juggle between these for different switcher effects. 
Conveniently, Vizrt’s Animation Store transitions support provides an effectively unlimited number 
of effects for every effects channel (including DSKs, Overlay channels, and the main Background 
Transition).

Vizrt’s Animation Store implementation makes setup almost unnecessary and switching less 
bothersome. In addition, Animation Store transitions support not just one but two embedded 
sound samples: one heard when flying on, and the other when flying off. But how do you create 
your own animation store transitions?

The included Animation Store Creator application allows you to easily author custom Animation 
Store transitions. You can use your preferred graphics software tools to prepare the animation 
sequence displayed during the transition, and then bring sounds and color together in a single 
easily applied transition using this tool.

1.1 Related Documents
Viz Verdi Switcher Guide: Contains information on how to install, configure and use Viz 
Verdi, and supported hardware.

1.2 Feedback And Suggestions
We encourage suggestions and feedback about our products and documentation. To give feedback 
and/or suggestions, please contact your local Vizrt customer support team at www.vizrt.com.

http://www.vizrt.com/
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2 Overview

The Animation Store Creator is the transition authoring application, and is attractive, simple, and 
user friendly. In simplest terms, it accepts one or two image sequences as inputs:

The first image sequence supplies the full color overlay.
A second sequence can be supplied to define the transition itself. This one is optional, since 
it is possible to create a transition without it by specifying a Cut Frame instead.

In addition, two optional sound files can be supplied, as mentioned previously, and you can also 
designate an icon for the new transition. On completion, transitions automatically appear in the 
correct location for convenient live use.

This section contains information on the following topics:

Launching the Application
Screen Layout

2.1 Launching The Application
The application is available from the Home page of the Startup screen on your Vizrt system.

For example, in the live video production suite, click the Add-Ons button on the icon ring and 
select the Animation Store Creator link shown at right.
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2.2 Screen Layout

The largest area of the screen is the canvas; this displays the result of your efforts. A scrub bar 
beneath the canvas (shown in detail below) lets you preview the effect as it will appear any point in 
time.
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Running down the left side of the canvas, you’ll see a stack of controls with standard menus 
shown at the top. The control groups in this section are briefly described in the table below.

Control 
Group

Description

Menus Allows you to save your project, export the finished transition (including exporting 
as an executable installer file), or view Help information.

Effect 
Type 
Settings

Governs the manner in which the transition proceeds.
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Control 
Group

Description

Overlay 
Controls

Allows import of files sequences defining the effect.

Transitio
n 
Controls

Allows import of files sequences defining the effect.

Audio 
Controls

Allows import of files sequences defining the effect.

Export 
Controls

Allows you to choose the most economical (in terms of memory) quality for your 
transition and assigns a thumbnail icon image to appear in the Live Desktop’s Trans
ition Bin.
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3 Getting Started
In this section, we’ll talk about the transition creation process. We’ll discuss the Animation Store 
Creator workflow, and the nature and purpose of the image sequences and audio files it 
uses. We’ll also look at the File menu output options, and project management.

This section contains information on the following topics and procedures:

Transition Design
Effect Type
Wipe Sequence
Warp Sequence
Audio Track
Animated Buffer
Export Properties
Menus

3.1 Transition Design
Let’s spend a moment considering the purpose of transitions as this relates to design and the 
order of operations in the Animation Store Creator software.

Setting aside all other aspects, a properly prepared transition accomplishes one of two things:

Applied to the live production suite’s Background video layer, it will ultimately swap the 
displays from the current Program and Preview row sources.
Or applied to an Overlay and DSK channel, it will introduce another source (commonly a title 
or graphic, but not limited to those options) to appear ‘above’ (or ‘in front of’) the Backgrou
nd video layer and remove it from view if the transition is run in reverse.

In both cases above, the transition manipulates two sources of imagery, which we can refer to as 
source A and source B:

At the beginning of a transition, only source A is displayed.
Source B is introduced as the transition progresses, either replacing source A (when the 
transition is applied in the  Background channel) or appearing superimposed above it (when 
applied to a DSK/Overlay channel).
An Overlay Animation constitutes an added source displayed above both source A and 
source B during the course of the transition, being completely removed from view when the 
transition ends.

In all cases, the way source B is introduced is governed by the controls and animation content (if 
any) you supply in the Wipe/Warp Sequence control group, discussed a bit later in, and by 
the Effect Type menu setting – discussed next.

3.2 Effect Type
Consider a simple transition. Overlay Animations (Overlay Animation Sequence) generally either 
begin with a fully transparent frame, gradually dissolving onto the screen; or it comes into view 
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from an off-screen location. In both cases, the overlay is removed from view by the end of the 
effect in one manner or another, fully revealing the newly introduced source.

Often, the Overlay Animation is designed to completely fill the screen at some point, allowing the 
actual transition to occur as a cut behind the animation. In this case, there is no need for a 
separate animation sequence to define the transition. Therefore, the Wipe Sequence controls allow 
you to simply specify (or Set the frame you are currently previewing as) the Cut Frame.

Otherwise, you can supply a simple black and white animation to define a transition as an 
animated blend of source A and B . The “Wipe” Effect Type supports both of these types of 
transitions (Details about animation sequences for Wipe transitions are provided in Wipe 
Sequence).

3.2.1 Warp A, Warp B, or Warp A and B
The Warp options in the Effect Type menu unleash some of Animation Store Creator’s most 
powerful capabilities. Using these options, the corresponding source (A, B or both) is completely 
governed by the animation you supply. The designated source can be moved, rotated, and 
distorted in endless ways:

Select Warp A to:

Fly source A off the screen, revealing source B behind it.
Or roll source A into a ball and roll it off the screen.

Select Warp B to animate source B:

Fade it up with a ripple to hide source A.
Or unroll source B like a scroll over top of source A.

The Warp A and B option in the Effect Type menu allows both sources to be completely governed 
by the animation you supply. This is achieved by adding blue to the warp gradient of the B source.

3.2.2 Overlay Animation Sequence
The next step when creating a new Animation Store Transition is to load an Overlay Animation.

Hint: The title of the Wipe/Warp Sequence control group varies depending on the Effect 
Type selection.



Note: Transitions prepared using the Warp A option are unsuitable for use in an Overlay or 
DSK channel.



Note: Information on preparing warp animations is provided in Warp Sequence. Be sure to 
supply an Overlay Animation when using this effect type.
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The Overlay Animation supplies the full color overlay imagery that appears on top of 
all Switcher video layer content (both sources: A and B) as they are displayed or removed when 
the effect is applied in the Live Desktop.

3.2.3 File Sequences
You will likely supply the Overlay Animation to the Animation Store Editor as an incrementally 
numbered file sequence. Typical animation and effects programs are capable of outputting 
suitable file sequences. File naming conventions for sequences often takes the form 
filename0001.png, filename0002.png, etc. (or perhaps filename.0001.png, or filename_0001.png).

The files should be prepared in a 32-bit format (with embedded alpha channel) of course, so the 
underlying Switcher sources is visible behind the overlay. Most common 32-bit file formats are 
supported, including PNG, TIFF, TARGA, and (flattened) PSD.

As an alternative to file sequences, the most common 32-bit animation file formats are also 
supported.

Frame Count
The number of images in the file sequence depends on your specific need. Typically, this sort of 
transition effect is not very long, often just one or two seconds. A two second transition intended 
to be played at normal speed (Medium, or [M] in the Transitions group on the Live Desktop) would 
look great with a sequence of 60 frames for NTSC, or 50 for PAL.

If you expect the transition will primarily be applied with a shorter duration you could use less 
frames, say just fifteen. (Using the lesser frame count when possible has the benefit of reducing 
demands for Effects Memory in the Switcher.)

The Media Browser
Click the drop-down menu labeled Frame Seq and click on Select File to open your media browser 
to locate your Animation Store sample files.

Hint: If your graphics application of choice does not automatically export 32-bit files in 
straight or non-premultiplied format, you should choose that option.
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The samples folder contains sub-directories holding the overlay file sequence (the folders are titled 
“overlay” or “warp”), the transition file sequence (“transition”) and sound files (“sounds”). Once you 
have selected your sample animation, select any one the PNG (or EXR) files in that folder and click 
open. The system automatically detects that it is an image sequence and loads it up in proper 
order.

Frame Rate and Interlace
The Frame Rate control allows you to choose appropriate settings for your target session format 
(PAL, or NTSC). As mentioned earlier (in File Sequences), you can choose a double-rate 
setting when you think it might be necessary to do so, but normally you should avoid this option, 
to minimize unnecessary use of Effects Memory.

Select Interlaced switch when the animation sequence is fielded to ensure smooth motion.

3.3 Wipe Sequence
The details of the animation sequence used to define the transition itself are fairly similar to the 
material we just discussed, with a few important distinctions.

The transition file sequence serves a different purpose than the overlay sequence does. It tells the 
Animation Store Creator what content will appear in each pixel of the screen at any given time 
during the effect.

At this point, you can supply either a black and white transition animation for simple pixel-
blending effects, or a UV-map gradient animation for more elaborate effects that move and warp 

Hint: Interlace support assumes upper field first order. NTSC SD D1 format frames 
(720x486 resolution, lower-field-first) are converted to this format if detected.



Note: This step is optional. If your overlay animation sequence completely fills the screen 
at any point, you can simply use the Cut Frame control to designate the frame where the 
change occurs. No transition sequence is required in this case.
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the video source (a suitable texture for use in warping animations is supplied in the folder at C:\...
\Effects\Animation Stores\Samples).

3.3.1 Simple Transitions
A very basic transition created with black and white imagery behaves as follows: White pixels in a 
given frame define the static background layer. Source B appears wherever black pixels exist in the 
current frame. Pixels partway in between black and white result in overlay transparency.

Let’s consider an example: Above, we see thumbnail icons for a black and white image sequence 
prepared to define a simple transition. As you can see, the first frame is white. The black section 
of each frame ‘grows’ from left to right as the sequence progresses.

 

For this sort of effect, the Effect Type option is set to Wipe. The canvas shows a frame about 
halfway through a transition. This shows the outcome at that frame as the transition sequence 
wipes the incoming source B over source A, which is already on the screen as the transition begins. 
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Applied to a DSK or Overlay channel, this simple Animation Store can be used to reveal a lower 
third type title, or as a full screen wipe.

3.4 Warp Sequence

As mentioned earlier, much more elaborate and complex transitions can be prepared using UV 
gradient animations (you can find a sample UV texture map to get you started in the folder at C:
\Program Files\Vizrt\...\Effects\Animation Stores\Samples).

Using suitable graphics software to distort and translate the supplied texture, you can create 
dynamic cloth effects to reveal your video and graphic sources.

Animations can be designed that move the gradient texture into or out of the frame. Depending on 
whether the animation is assigned to source A or B (using the Warp A or Warp B options in the 
Effect Type menu), the animation can remove the current source, introduce a new one in its place, 
or reveal an incoming overlay.

You’ll find example file sequences in the content supplied with your Animation Store Creator. 
Examine these files to gain a good understanding of the relationship of the overlay and transition 
animation sequences and how the Wipe, Warp A and Warp B options affect the resulting effect.

3.5 Audio Track

You can optionally select sound files for your transition using file menus labeled Fly On and Fly Off
in the Audio control group.

Files should be a suitable length, naturally. Most common audio file formats are compatible 
(including .wav and .mp3).

Audio can be extracted from video file formats. This allows you to use the same video file as both 
the frame sequence and audio source (under their respective menus).

Hint: Audio levels for transitions can be controlled in the live production suite’s Audio 
Mixer.
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3.6 Animated Buffer
A more recent addition to the Effect Type menu is Animated Buffer.

Animated Buffer  provides powerful animation effects that can be used independently of Media 
Players, effectively allowing you to inject animation freely all throughout your productions. They 
serve particularly well in DSKs and M/E Key layers but can also provide useful elements for M/E 
compositions, and more.

Selecting this Effect Type option updates the Control Stack to display relevant options and settings 
in the area below:

The Frame Seq. selector (Animation control group) lets you choose a file sequence (or animation 
clip in common formats, including those with embedded alpha channel). The Resolution and 
Frames display fields update after loading the file(s).

3.6.1 Play Mode
The video production suite’s Buffer system supports three types of animated effects. Select Loop, 
Single, or Ping Pong using the Play Mode menu, according to the type of effect you require.

3.7 Export Properties
The last control group is labeled Export Properties. The Quality drop-down menu has three 
optional settings. Generally, the Normal or High setting will do. Consider using Ultra only for 
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3.
4.
5.
6.

7.

8.

situations involving highly detailed imagery in the overlay channel, and especially slow transition 
speeds.

To select an icon for the new transition to be generated, drag the scrub bar beneath the canvas to 
a suitable frame and click the Set button in the Export Properties group.

3.8 Menus
Two primary menus sit at upper left, just beneath the application title bar. Let’s consider the 
features found in the File and Help menus.

3.8.1 The File Menu
The file menu permits you to save and re-open transition projects and export your results.

New: Opens a new, blank project.
Open: Opens a previously stored transition project to continue working with it.
Recent: Shows a list of recently active transition projects.
Save: Stores the current project.
Save As: Saves a copy of the current project with a new name.
Export to: Compiles the finished transition and store it in the correct location for live use. 
Note that the optional targets listed in the menu can include various types of NDI systems 
detected on the local network; naturally only supporting live video mixing systems are 
suitable destinations.
Create Installer: Creates a standalone installer (.exe) file that you can share with another 
Vizrt live production suite user.
Exit

3.8.2 Create Installer
Select the File menu point Create Installer to open the dialog panel shown below.

Hint: Again, using unnecessarily high settings without a good reason simply wastes 
valuable Effects Memory.
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Enter information for the different fields listed and select either Browse (to locate a custom file you 
have prepared) for the file entries listed below or select Use Default.

Once you have completed these steps, press the Create button at the bottom of the panel. After 
you supply a filename, a progress gauge will be shown as the standalone installer file (.exe) is 
prepared.
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4 NDI
What is NDI?

In a nutshell, Network Device Interface (NDI) technology is the world’s most prolific video over IP 
protocol for live production. NDI allows systems and devices to identify and communicate with 
each other, and to encode, transmit, and receive high quality, low latency, frame-accurate video 
and audio over IP in real time.

NDI enabled devices and software have the potential to greatly enhance your video production 
pipeline, by making video input and output available anywhere your network runs. Vizrt systems 
and a growing number of third-party systems provide direct support for NDI, both for ingest and 
output. Although Viz 2110 IO provides many other useful features, it is purpose designed 
primarily to turn SMPTE 2110 sources into NDI signals and vice versa.
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5 Third Party Licenses
This product uses a number of third-party software libraries under license. Related license 
requirements are defined in documentation installed on the product. To view these licenses, 
please click the Additional Licenses link provided in the Help menu on the Startup > Home page 
shown upon launching the product.
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